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INTRODUCTION 

EKIO is a Loudspeaker Management Application. It lets you customize the sound of your loudspeaker 

system so that it sounds and performs optimally. The app allows you to easily create a crossover for 

your full-range speakers and subs. 

EKIO can import speaker measurements, allowing you to achieve the finest settings, and get the best 

audio performance. 

EKIO is a Windows application that works with an ASIO1 audio interface. If your device has no native 

ASIO drivers, you can still use EKIO by using a generic ASIO driver. 

 

Disclaimer/Warning 

Lupisoft cannot be responsible for any damage that may result from the improper use of this product. 

An incorrect EKIO configuration could damage your audio system. Therefore, we do recommend that 

you carefully read this manual and other technical notes to ensure that you fully understand how to 

use this software.  

It is better to switch-off all your devices when you change the configuration of your system. Once all 

your settings are set and verified, you can turn your devices on and start the audio processing. 

SOFTWARE INSTALLATION 

To operate, EKIO requires that the Microsoft .NET Framework 4.0 (Client Profile or Full) be installed on 

your computer. If this is not the case, you can download it for free on the Microsoft website and install 

it. 

Installing EKIO is simple. Double-click the installation file and follow the instructions. 

EKIO requirements 

 Windows 10, 8, 7 

 .NET Framework 4.0 

SETTING UP YOUR SYSTEM 

There are many ways in which to integrate EKIO into your system. 

                                                           

1 ASIO is a trademark of Steinberg Media Technologies GmbH. 

http://www.steinberg.net/
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For example, EKIO can be used with an ASIO audio interface. This solution provides the best 

performance, especially in terms of latency. But it can also work with a sound card that has no native 

ASIO driver. In this case, one uses generic drivers, such as ASIO4ALL2. 

Detailed explanations of the different ways to integrate EKIO into your system are available on our 

website. You will find how to: 

 use EKIO with an ASIO audio interface 

 use EKIO with a sound card that does not support ASIO 

 output via HDMI 

 filter an external source 

 filter Windows sounds 

 etc. 

  

                                                           

2 Universal ASIO Driver For WDM Audio 

http://www.asio4all.com/
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OVERVIEW OF THE EKIO INTERFACE 

A CONFIG is a consistent set of software settings for a given application. It can be created, edited, 

saved to file, loaded, closed, etc. 

This is the main window of EKIO:

 

It comprises the following four elements: 

Menu  
The menu allows acting on the config as well as on the general parameters of the software. 

Config selection 
This drop-down button selects what config is being edited. Several configs can be loaded into the 

software but only one is selected at a given time. 

Config edition 
It is in this area that we edit the selected config. 

Playback button 
When the config is ready, this button is used to start the audio processing. 

 

The software is typically used as follows: 

1. Create a new config 

2. Select a sample rate (Settings tab) 

3. Create inputs and outputs (Inputs/Outputs tab) 

4. Connect inputs to outputs (Routing tab) 
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5. Edit config settings: gain, delay, equalizer, crossover (Inputs/Outputs tab and EQ tab) 

6. Visualize the results on the graphics (EQ tab) 

7. Select an audio driver (Settings tab) and select the input and output channels (Inputs/Outputs 

tab) 

8. Start the audio processing 

This is described in more detail later in this document. 

MENU 

The menu items are: 

File > New 
Creates a new config. 

File > Open 
Loads a config located on the disk. Config files have the extension “.ekio”. 

File > Duplicate 
Creates a new config, which is a copy of the selected configuration. To be differentiated, the new 

config bears the name of the original configuration, followed by “- Copy”. 

File > Close 
Closes the currently selected config. 

File > Close All 
Closes all configurations opened in the software. 

File > Save 
Saves the currently selected config. If it does not already have a file name, the user is requested to 

enter one. 

File > Save As… 
Saves the currently selected config with a new name. 

File > Exit 
Exits the application. 

Options > Preferences 
Opens the application preferences window (see Preferences). 

? > Visit EKIO Website 
Opens the EKIO website in your default web browser. 

? > Check for updates 
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Checks if a newer software version is available for download on the Lupisoft website (your computer 

must be connected to the Internet). 

To install a new version of the software, follow these steps: 

1. if EKIO is running, terminate the application 

2. uninstall the software from your computer 

3. install the new version 

The user license is kept during operation. Nevertheless, we recommend that you always keep a copy 

of your license in a safe place. 

? > License management 
Opens the license management window (see License management). 

? > About 
Opens the About window. It displays the software version and the license agreement that you must 

accept when you install the software. 

CONFIG SELECTION 

Several configurations can be loaded simultaneously into the software. But only one can be edited at 

once. This drop-down menu lets you choose the configuration that you want to edit. It is possible to 

switch from one to another when desired. 
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INPUTS/OUTPUTS TAB 

 

This tab is divided into two parts. The upper part allows manipulating input strips. The lower part 

allows manipulating output strips. An input strip receives an audio signal from the sound card, while 

an output strip sends an audio signal to the sound card. 

Each strip can apply effects to the audio signal: gain, delay, polarity inversion, mute, solo, and EQ. All 

settings are accessible directly on the strip, except for the equalizer settings, which are set in the EQ 

tab (see Eq Tab). 

The input strips are connected to the output strips in the ROUTING tab (see Routing Tab). 

Control buttons 

To perform some actions, a strip must be selected. To select a strip, click on it, anywhere. 

The following buttons are used to act on the strips: 

 
Adds a new input strip (or output strip) at the end of the list. 

 
Deletes the selected input strip (or output strip). 
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Copies the selected input strip (or output strip) into a buffer. 

 
Copies the strip written into the buffer at the end of the input strip list (or output strip list). 

 
Moves the selected input strip (or output strip) one place to the left. 

 
Moves the selected input strip (or output strip) one place to the right. 

Input Strip 

The following is an overview of the main elements in the input strip: 

 

Strip number 
This is the number of the strip inside the list. 

Name 
A textbox where you can enter the name of the strip. 

Input path 
Sets the channel strip's input path. If no audio channel is available, go to the SETTINGS tab and choose 
an audio driver (see ASIO Settings). 
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You can force the software to display more channels by changing the property ASIO INPUT/OUTPUT 
LISTS LENGTH into the PREFERENCES window (see Preferences). 

Mute button 
Activating the mute button will mute the corresponding strip. 

Solo button 
Solos and unsolos the channel strip. 

Gain 
Amplifies or attenuates the audio signal with a gain between -70 and +12 dB. 

Peak level meter 
Updates during playback to show the highest peak level reached. 

Level meter 
Displays an input strip’s monitoring level. 

Delay 
Applies a delay to the signal, between 0 and 150 ms. 

EQ button 
This button allows editing the equalizer of the strip. When clicked, the EQ tab is opened and the 

corresponding strip is selected (see EQ strip selection). 

Output Strip 

The following is an overview of the main elements in the output strip: 
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Strip number 
This is the number of the strip inside the list. 

Name 
A textbox where you can enter the name of the strip. 

Mute button 
Activating the mute button will mute the corresponding strip. 

Solo button 
Solos and unsolos the channel strip. 

EQ button 
This button allows editing the equalizer of the strip. When clicked, the EQ tab is opened and the 

corresponding strip is selected (see EQ strip selection). 

Delay 
Applies a delay to the signal, between 0 and 150 ms. 

Gain 
Amplifies or attenuates the audio signal with a gain of between -70 and +12 dB. 

Peak level meter 
Updates during playback to show the highest peak level reached. 

Level meter 
Displays a channel strip’s playback monitoring level. 
The meter displays the level of the audio signal (after the gain is applied) just before it is sent on ASIO 
output. 
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This meter displays dBFS (dB full scale) values. Be sure to keep the signal below 0 dBFS or it will clip. 

Output path 
Sets the channel strip's output path. If no audio channel is available, go to the SETTINGS tab and 
choose an audio driver (see ASIO Settings). 
You can force the software to display more channels by changing the property ASIO INPUT/OUTPUT 
LISTS LENGTH into the PREFERENCES window (see Preferences). 

ROUTING TAB 

This tab allows connecting the input strips to the output strips. 

 

The table shows all of the possible connections between the input strips and the output strips. The 

rows represent the inputs, while the columns represent the outputs. At each intersection between a 

row and a column is a button. Click the button to turn it ON or OFF. When the button is ON, the 

corresponding input and output are connected: the output receives the audio signal from the input. 

When the button is OFF, they are disconnected. 

When several inputs are connected to the same output, the output receives the sum of all connected 

input signals. 
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EQ TAB 

 

In this tab, you can edit the equalizer of the strips and see the effect of filtering on the graphics. The 

screen is divided into three parts: 

Eq 
This is where we edit the equalizer settings. 

Output Selection  
Selects which outputs are displayed in the Graphics area. 

Graphics 
This is where all of the graphics are displayed.  

Eq 

This area allows editing the equalizer of the input and output strips.  
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It is composed of the following elements: 

Strip selection 
This drop-down list displays all of the input and output strips. Select the strip on which you want to 

edit the equalizer. 

General settings 
This section has three settings: 

GAIN 
Applies a gain to the audio signal. Its value ranges from -100 to +15 dB. The slider covers a range from 

-15 to +15 dB. To go beyond, enter the value manually into the text field. 

DELAY 
Applies a delay to the audio signal. Its value ranges between 0 and 150 ms. The slider covers a range 

from 0 to 3 ms. To go beyond, enter the value manually into the text field. 

INVERT 
Inverts the audio signal's polarity. 

Parametric EQ 
In this area, we create the parametric filters (PEQ) applied to the audio signal and we set their 

parameters. 

The filters are listed one above the other. 
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Buttons 

The buttons act on the filters. Some require that a filter be selected. To select a filter, click on it, 

anywhere, so that it appears highlighted. 

The buttons perform the following actions: 

 ADD: adds a new filter at the end of the list. By default, the selected type is the BELL filter. You 

can edit it to choose another type. 

 DELETE: deletes the selected filter 

 CLEAR ALL: removes all filters 

 UP: moves the selected filter one place up 

 DOWN: moves the selected filter one place down 

 COPY: copies the selected filter into a buffer 

 PASTE: copies the values of the buffered filter into a new filter 

PEQ filters 

They can be disabled by checking their  button (Bypass).  

The color of a PEQ filter is displayed on its left. To change it, double-click on it. 

Available filters are: 

High pass and Low pass 

The LOW PASS FILTER passes frequencies below the cutoff frequency and drastically attenuates above 

the cutoff. This is opposite to the HIGH PASS FILTER, which allows high frequencies and blocks lower 

than the cutoff. 

Their parameters are: 

TYPE:  

 BW stands for Butterworth. When two Butterworth filters are summed, a 3dB increase in level 

will be created at the crossover frequency.  

 LR stands for Linkwitz–Riley. When two Linkwitz–Riley filters are summed, there is no increase 

in level around the crossover frequency, which makes these types of filters very popular.  

 BESSEL filters provide the best transient response but their transition from the pass band to 

the stop band is slower than for other filters. 

SLOPE: this parameter adjusts the slope rate of the filter beyond the cutoff frequency. Lower settings 

yield a more gradual slope. 

FREQ: cutoff frequency 

Bell 

The BELL FILTER allows you to selectively emphasize or attenuate a limited band of the audio 

spectrum. 

Its parameters are: 

FREQ: adjusts the center frequency of the band to be treated.  
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Q: adjusts the width of the band to be treated. Lower Q settings provide wider filters, affecting a wider 

range of frequencies when adjusted. Higher Q settings provide narrower filters, which affect fewer 

frequencies when adjusted. 

PEAK: sets the applied gain. 

Low shelf and High shelf 

A LOW SHELF FILTER will cut or boost signals of frequencies below the transition frequency (fc). Above 

fc, the frequency response will not be altered and will pass normally.  

A HIGH SHELF FILTER will cut or boost signals of frequencies above the transition frequency (fc). Below 

fc, the frequency response will not be altered and will pass normally. 

Their parameters are: 

FREQ: transition frequency 

Q: this parameter adjusts the slope rate of the filter at the transition frequency. Lower settings yield a 

more gradual slope. Higher settings produce a steeper slope. 

PEAK: amount of cut or boost to apply (in dB). 

Export biquads 

Parametric filters are implemented as biquads. EKIO allows exporting their coefficients, so you can 

load the filters on another device. 

 

Information 
NUMBER OF BIQUADS: indicates the number of biquads needed to implement all of the parametric 

filters. 
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SAMPLING RATE: displays the sample rate of the configuration (defined in ASIO Settings). Note that 

the published coefficients are valid at this sample rate ONLY. Make sure that the device to which you 

transfer the coefficients operates at this sampling frequency. 

Biquad coefficients 
This window lists the biquad coefficients. For each PEQ filter, a line between [ ] describes the filter and 

its parameters. It is followed by one or more biquads. Each biquad consists of five coefficients: B0, B1, 

B2, A1, and A2. 

Two settings are available: 

 HIDE [PARAMETERS]: masks the lines between []. This is useful when you want to export only 

the coefficients, without the PEQ parameters. 

 INVERT A1/A2 SIGN: inverts the sign of coefficients A1 and A2. This is useful to transfer the 

coefficients to a MiniDSP, for example. 

The buttons let you perform the following actions: 

 COPY TO CLIPBOARD: copies the content of the window into the clipboard. 

 SAVE AS…: saves the content of the window coefficients into a file. 

 CLOSE: closes the window. 

Output Selection 

This allows you to select which outputs are displayed in the graphics, to assign them a color, and to 

associate them with measurements. 

 

This window lists all of the available outputs. Each line corresponds to an output. All have the 

following elements: 

Select color 
This colored button displays the color of the output strip. This is useful for graphics. Click the button to 

modify the color. 

Output number 
Displays the output number. 

Output name 
Displays the output name. 
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Display button 

Checking this button (  ) selects the output to make it appear on the graphics. Uncheck this button 

(  ) if you don’t want the output to appear. 

Import measurements button    
Click on this button to open the IMPORT MEASUREMENT window, which lets you assign 

measurements to the output (see Import Measurement Window). 

Import measurements window 
In this window, you can assign measurements to an output. 

If an output is connected to a speaker, you can import its frequency response measurement into the 

software. This way, EKIO can calculate what the frequency response of the speaker is when the filters 

are applied. 

The window is divided into three parts: on-axis measurements, horizontal off-axis measurements, and 

vertical off-axis measurements. 

 

 

On-axis measurement 

In this section, you can import the frequency response measured on the axis of the speaker. This 

measurement is used by the FREQUENCY RESPONSE graphic (see Frequency Response Graphic) and 

the GROUP DELAY graphic (see Group Delay Graphic). 

file:///D:/Développement/projet_audio/Manuel%20d'utilisation/_Frequency%23_Graphique_
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 : clicking on this button opens a selection window that lets you choose the file to import. You can 

also manually enter its name into the field. 

 : deletes the field.  

Two settings are applied to the imported measure: 

 GAIN OFFSET: applies a gain to the measurement, ranging from -150 dB to +150 dB. 

 DELAY: adds a delay to the measurement, ranging from -150 ms to +150 ms. 

Horizontal off-axis measurements 

In this section, you can import the frequency responses measured off-axis, on a horizontal plane. 

Those measurements are used by the OFF-AXIS RESPONSE graphic with ORIENTATION set to 

HORIZONTAL (see Off-Axis Response Graphic). 

 

Each line of the list corresponds to a measurement and contains the following fields: 

 SELECT: uncheck this button to hide the measurement on the graphics, without deleting it. 

 ANGLE: enter the angle of the measurement into this field. Every angle must have a different 

value. 

 FILENAME: displays the file name of the measurement. 

The three buttons perform the following actions: 

 ADD: adds one or more measures. Click this button to open a file selection window. 

 DELETE: deletes the selected measurement(s). To select a measurement, click on the 

corresponding line. 

 CLEAR: deletes all measurements. 

The following two settings are applied to all measurements in the list: 

 GAIN OFFSET: applies a gain to all measurements in the list (from -150 dB to +150 dB). 

 DELAY: adds a delay to all measurements in the list (from -150 ms to +150 ms). 
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Note 

When a measure is added using the ADD button, the software can read the angle of the 

measurement into the file name. For this, the file name must have the predefined form: 

“..._deg[+/-]<angle>...” 

The file name must contain the keyword “_deg”, immediately followed by the measurement 

angle in degrees. The angle value can be an integer or decimal (e.g., _deg45, _deg22.5) optionally 

preceded with a plus or a minus sign (e.g., _deg10, _deg+30, _deg-45). 

Examples of valid file names: 

MidWoofer_deg+0.txt 

Medium_deg45.Farfield.txt 

Tweeter_HO_deg-22.5.txt 

Vertical off-axis measurements 

In this section, you can import the frequency responses measured off-axis, on a vertical plane. Those 

measurements are used by the OFF-AXIS RESPONSE graphic with ORIENTATION set to VERTICAL (see 

Off-Axis Response Graphic). 

Operation is identical to the previous section. 

Measurement file format 

The measurement files are text files written with the following structure: 

[header] 
<frequency><separator><magnitude><separator><phase> 
<frequency><separator><magnitude><separator><phase> 
<frequency><separator><magnitude><separator><phase> 
 
With: 

[header]: optional header 
<frequency>: frequency in Hz 
<separator>: may be composed of spaces, tabs or a semicolon 
<magnitude>: magnitude in dB 
<phase>: phase in degrees 
 

The phase can be wrapped or unwrapped. The decimal separator is a dot. 

Example: 

# Woofer A measurement 
0 -50.4277416519 -181.087643279 
5 -49.8484750329 -188.610750555 
10 -47.6752662956 -202.691690774 
15 -47.1882385137 -203.055846114 
20 -44.4884864254 -210.713279311 
25 -44.0139520572 -206.436586045 
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Graphics 

The graphics area can hold up to five graphics. To add one, click on the button ADD GRAPHIC. 

Common buttons 

The following buttons are common to all graphics. 

 

 

 GRAPHIC TYPE: allows choosing the type of chart. There are five types: EQ, FREQUENCY 

RESPONSE, OFF-AXIS FREQUENCY RESPONSE, GROUP DELAY, and TRANSFER FUNCTIONS. 

 OPTIONS: displays the options of the graphic. They differ depending on the graphic type. 

The following option is common to all graphics:  

SYNCHRONIZE FREQUENCY AXIS: all graphics with this option enabled have their 

frequency axis synchronized. When the frequency axis of a graphic is moved, the 

modification is applied to all of the others. When this option is disabled, the axis can 

be moved independently of the others. 

 EXPORT IMAGE: click on this button to open the EXPORT IMAGE window. It allows exporting 

the graphic as an image either into a file or into the clipboard. 

 MOVE UP: moves the graphic up. 

 MOVE DOWN: moves the graphic down. 

 CLOSE: closes the graphic. 

Common actions 

The following actions can be applied to all graphics: 

 ZOOM IN: to zoom in, surround the area in which you are interested with the mouse. Click 

inside the graphic to define the first corner of the zoom window. Hold the button down and 

move the pointer to the location of the opposite corner. Finally, release the button. 

 ZOOM OUT: to zoom out, move the mouse pointer anywhere inside the graphic and click with 

the right button. 

 MOVE AXIS: to move an axis, click on it with the left mouse button and then move the mouse 

along the axis while holding the button down. Finally, release the button. 

 DISPLAY CURSOR POSITION: when the mouse is over a graphic, press the SHIFT KEY to display 

the cursor position. 

EQ Graphic 
This graphic displays the curves of the equalizer that is currently edited (see EQ Strip selection). It 

shows: 
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 The curve of the resulting filter (with orange color) 

 the curves of all PEQ filters 

You can edit a PEQ filter directly on the graphic. To do this, click the handle located on its curve. While 

holding down the mouse button, drag it to the desired position. Then release the button. 

You can hold down the CONTROL key while you move the handle of a BELL filter, a LOW SHELF or a 

HIGH SHELF filter. This allows adjusting the value of the Q parameter. 

Two options are available: 

 SHOW INDIVIDUAL PHASES: displays the phase curves of the PEQ filters. 

 SHOW TOTAL PHASE: displays the phase curve of the resulting filter. 

Frequency Response Graphic 
This graphic displays the frequency responses of the selected outputs and the frequency response of 

their sum. 

Frequency responses take into account the on-axis measurements applied to outputs (see On-axis 

measurement). 

SMOOTHING: this drop-down list lets you choose what smoothing is applied to the curves. 

The available options are:  

 SHOW TOTAL MAGNITUDE: displays the magnitude of the total frequency response. The total 

frequency response is equal to the sum of the frequency responses of the selected outputs.  

 SHOW TOTAL PHASE: displays the phase of the total frequency response.  

 SHOW INDIVIDUAL MAGNITUDES: displays the magnitudes of the frequency responses of the 

selected outputs. 

 SHOW INDIVIDUAL PHASES: displays the phases of the frequency responses of the selected 

outputs. 

Off-Axis Response Graphic 
This graphic displays the off-axis response curves of the sum of the selected outputs. The angles 

shown are those with which measurements have been associated (see Horizontal Off-axis 

measurements and Vertical off-axis measurements). 

The curve corresponding to a given angle is displayed if all outputs have a measurement associated 

with that angle. For example, outputs 1 and 2 are selected. The graphic displays the off-axis response 

curve of their sum. Output 1 has measurements associated with angles 0, 10, 20, 30 and 40 degrees. 

Output 2 has measurements associated with angles 0, 20, and 40 degrees. The graphic displays the 

curves corresponding to angles 0, 20 and 40 degrees (because these are the only angles for which 

measurements are available on each output). 

SMOOTHING: this drop-down list lets you choose what smoothing is applied to the curves. 

ORIENTATION: this button lets you choose between the following: 

 HORIZONTAL: the horizontal off-axis measurements are used (see  Horizontal Off-axis 

measurements). 



23 
 

 VERTICAL: the vertical off-axis measurements are used (see Vertical off-axis measurements). 

There are no other OPTIONS available. 

Group Delay Graphic 
This graphic shows the group delay of the selected outputs (see Output Selection) and the group delay 

of their sum. 

The available OPTIONS are: 

 SHOW TOTAL: displays the group delay of the sum of the selected outputs. 

 SHOW INDIVIDUALS: displays the group delay of the selected outputs. 

Transfer Function Graphic 
This graphic displays the transfer functions of the selected outputs. 

The available OPTIONS are: 

 SHOW PHASES: displays the phases of the transfer functions. 

SETTINGS TAB 
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General Settings 

Sampling Rate 

Selects the sample rate of the config. 

ASIO Settings 

Driver 

This drop-down list lets you choose the ASIO driver that you want to use for playback. 

Request buffer size 

Here you specify the size of the audio buffers used during playback. A small size provides a low latency 

but can cause crackles during playback. A larger size increases latency but allows avoiding cuts. 

To define a buffer size, check the button and enter a value into the field. Uncheck the button to let the 

driver choose its preferred buffer size. 

Information 

The fields NAME, AUTHOR(S) and DESCRIPTION allow you to describe the configuration. The 

FILENAME field displays the name of the file associated with the config. 

PLAYBACK BUTTON 

Play/stop the selected config. 

When the config is ready, click on this button to start the real-time audio processing. EKIO will receive 

audio signals from the sound card on its inputs, apply the defined filters, and send the result to its 

outputs. 

If the playback doesn’t start, check that a driver is selected (see ASIO Settings). Note that the ASIO 

driver must be able to operate at the sampling frequency set in the Settings tab (see Settings Tab). If 

this is not the case, EKIO will display an error message. 

PREFERENCES 

Preferences allow you to define some of the basic operating parameters of EKIO. This section explains 

each of these preferences. 

You can access this window via the OPTIONS > PREFERENCES menu. Activate or deactivate the 

preferences. Then close the window once you’ve made your selections. 
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Preferences are automatically saved whenever you click the OK button. The settings made in the 

Preferences window are saved in a general preference file. Preference settings apply to all configs. 

 

 

On Windows Startup 

This section allows configuring the behavior of EKIO at Windows startup. 

START EKIO WHEN WINDOWS STARTS 
If checked, EKIO will start automatically each time Windows starts. 

MINIMIZE WINDOW 
Minimize the application when EKIO starts with Windows. 

LOAD CONFIG 

This loads a config when EKIO starts with Windows. Click on the button  to choose the config or 

enter its name directly into the field. 

PLAY CONFIG 
Plays the loaded config when EKIO starts with Windows. 

WAIT N SECONDS BEFORE LOADING CONFIG 
Wait N seconds before playing the loaded config. This is useful if you want EKIO to wait that some 

drivers or software are completely loaded before it starts its processing. 

Misc 

CLOSE/MINIMIZE TO SYSTEM TRAY 
When this option is checked, EKIO no longer appears in the taskbar, but in the system tray (in the 

bottom right of the screen). 

ASIO INPUT/OUTPUT LIST LENGTH 
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This defines the size of the list of channels displayed in an input strip (see Input Strip) or in an output 

strip (see Output Strip). This is a minimum size. If the selected ASIO driver has more channels than the 

size specified, all channels are displayed. 

LICENSE MANAGEMENT 

A user license can be purchased on the EKIO website. 

In this window, you can activate your license. You can do it either online (if your computer is 

connected to the Internet) or offline. A license can only be activated on a single computer at a time. If 

you wish to transfer your license from one computer to another, you have to disable it on the first one 

before you can activate it on the second one. 

To open the window LICENSE MANAGEMENT, click on the menu ? > LICENSE MANAGEMENT. 

The available actions are: 

Activate online 

This allows you to activate your license online. This is the easiest and fastest way in which to get your 

license activated. 

When you purchase the software, you receive a license via email. Copy this license into the clipboard 

(Ctrl + C), and then paste it into the textbox located after ENTER YOUR LICENSE. Then click the button 

ACTIVATE. You have to restart the software for the license to take effect. 

Activate offline 

If your computer is not connected to the Internet, you can use the offline activation. 

Send us an email with your license and the MACHINE CODE displayed on the screen. We will send you 

an ACTIVATION CODE that you will enter in the appropriate textbox before clicking on the ACTIVATE 

button. 

Deactivate 

To deactivate the license, click on the DEACTIVATE button. 

The software returns to the free version. The license can now be activated on another computer. This 

method is useful when a user needs to migrate the software from one machine to another machine. 

This action will fail if the computer is not connected to the Internet. 

Buy 

Clicking on the VISIT US HERE link will direct you to the application's website. 
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ADDITIONAL RESOURCES 

Lupisoft Website 

http://www.lupisoft.com 

EKIO Product Page 

http://www.lupisoft.com/ekio 

Lupisoft Support 

mailto:contact@lupisoft.com 

 

http://www.lupisoft.com/
http://www.lupisoft.com/ekio
mailto:contact@lupisoft.com

